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Introduction

Introduction

This chapter provides information on the purpose of the manual, safety information, and additional
documents and resources.
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Purpose

Purpose

The Class 6 D-Style SmartMotor™ Installation and Startup Guide (the document you are currently reading)
provides an overview of the Class 6 D-style SmartMotor, along with information on unpacking, installation
and start up. This guide is meant to be used in conjunction with the SmartMotor™ Developer's Guide, which
describes the SmartMotor features, SMI software, programming, commands, and other topics related to
SmartMotor application development.

NOTE: The features described in this guide apply to the Class 6 D-style SmartMotor with firmware
version 6.4.x.x (6.4.2.54 or later is recommended). Additionally, those motors require SMI software
version 3.0.0.73 or later for complete feature support.

Class 6 D-Style SmartMotor

The information in this guide is meant to be used by properly trained technical personnel only. Moog
Animatics conducts classroom-style SmartMotor training several times per year, as well as product
seminars and other training opportunities. For more information, please see the Moog Animatics website or
contact your Moog Animatics representative.

Combitronic Technology

The most unique feature of the SmartMotor is its ability to communicate with other SmartMotors and share
resources using Moog Animatics’ Combitronic™ technology. Combitronic is a protocol that operates over a
standard CAN interface. It may coexist with the CANopen protocol. It requires no single dedicated
controller? to operate. Each SmartMotor connected to the same network communicates on an equal
footing, sharing all information, and therefore, sharing all processing resources.

NOTE: Combitronic over Ethernet, which allows Combitronic communication on the Industrial Ethernet
network, is not currently available on the Class 6 D-style SmartMotor.

For additional details, see the SmartMotor™ Developer's Guide.

TMoog Animatics has replaced the terms "master" and "slave" with "controller" and "follower", respectively.
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1/0O Device CAN Bus Controller

I/0O Device CAN Bus Controller

Expanded I/O capability allows the SmartMotor to interface with standard CiA 301 CANopen devices and
function as the 1/0 device CAN bus controller (i.e., no external bus controller is needed). For more details,
see the SmartMotor™ Developer's Guide. For CANopen object descriptions, see the SmartMotor™

CANopen Guide.
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Be sure to comply with the guidelines for CAN bus cabling and termination.

SmartMotor as I/0 Device CAN Bus Controller
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Safety Information

Safety Information

This section describes the safety symbols and other safety information.

Safety Symbols

The manual may use one or more of these safety symbols:

WARNING: This symbol indicates a potentially nonlethal mechanical hazard, where
failure to comply with the instructions could result in serious injury to the operator or

major damage to the equipment.

CAUTION: This symbol indicates a potentially minor hazard, where failure to comply
with the instructions could result in slight injury to the operator or minor damage to the

equipment.

NOTE: Notes are used to emphasize non-safety concepts or related information.

Other Safety Considerations

The Moog Animatics SmartMotors are supplied as components that are intended for use in an automated
machine or system. As such, itis beyond the scope of this manual to attempt to cover all the safety
standards and considerations that are part of the overall machine/system design and manufacturing safety.
Therefore, this information is intended to be used only as a general guideline for the machine/system
designer.

Itis the responsibility of the machine/system designer to perform a thorough "Risk Assessment" and to
ensure that the machine/system and its safeguards comply with the safety standards specified by the
governing authority (for example, ISO, OSHA, UL, etc.) for the site where the machine is being installed
and operated. For more details, see Machine Safety on page 10.

Motor Sizing

It is the responsibility of the machine/system designer to select SmartMotors that are properly sized for the
specific application. Undersized motors may: perform poorly, cause excessive downtime or cause unsafe
operating conditions by not being able to handle the loads placed on them. The System Best Practices
document, which is available on the Moog Animatics website, contains information and equations that can
be used for selecting the appropriate motor for the application.

Replacement motors must have the same specifications and firmware version used in the approved and
validated system. Specification changes or firmware upgrades require the approval of the system designer
and may require another Risk Assessment.

Environmental Considerations

It is the responsibility of the machine/system designer to evaluate the intended operating environment for
dust, high-humidity or presence of water (for example, a food-processing environment that requires water
or steam wash down of equipment), corrosives or chemicals that may come in contact with the machine,
etc. Moog Animatics manufactures specialized IP-rated motors for operating in extreme conditions. For
details, see the Moog Animatics Product Catalog.
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Machine Safety

Machine Safety

In order to protect personnel from any safety hazards in the machine or system, the machine/system
builder must perform a "Risk Assessment", which is often based on the ISO 13849 standard. The
design/implementation of barriers, emergency stop (E-stop) mechanisms and other safeguards will be
driven by the Risk Assessment and the safety standards specified by the governing authority (for example,
ISO, OSHA, UL, etc.) for the site where the machine is being installed and operated. The methodology and
details of such an assessment are beyond the scope of this manual. However, there are various sources of
Risk Assessment information available in print and on the internet.

NOTE: The next list is an example of items that would be evaluated when performing the Risk
Assessment. Additional items may be required. The safeguards must ensure the safety of all personnel
who may come in contact with or be in the vicinity of the machine.

In general, the machine/system safeguards must:

« Provide a barrier to prevent unauthorized entry or access to the machine or system. The barrier must
be designed so that personnel cannot reach into any identified danger zones.

« Position the control panel so that it is outside the barrier area but located for an unrestricted view of
the moving mechanism. The control panel must include an E-stop mechanism. Buttons that start the
machine must be protected from accidental activation.

» Provide E-stop mechanisms located at the control panel and at other points around the perimeter of
the barrier that will stop all machine movement when tripped.

« Provide appropriate sensors and interlocks on gates or other points of entry into the protected zone
that will stop all machine movement when tripped.

« Ensure that if a portable control/programming device is supplied (for example, a hand-held
operator/programmer pendant), the device is equipped with an E-stop mechanism.

NOTE: A portable operation/programming device requires many additional system design
considerations and safeguards beyond those listed in this section. For details, see the safety
standards specified by the governing authority (for example, ISO, OSHA, UL, etc.) for the site
where the machine is being installed and operated.

» Prevent contact with moving mechanisms (for example, arms, gears, belts, pulleys, tooling, etc.).
» Prevent contact with a part that is thrown from the machine tooling or other part-handling equipment.

« Prevent contact with any electrical, hydraulic, pneumatic, thermal, chemical or other hazards that
may be present at the machine.

« Prevent unauthorized access to wiring and power-supply cabinets, electrical boxes, etc.

» Provide a proper control system, program logic and error checking to ensure the safety of all
personnel and equipment (for example, to prevent a run-away condition). The control system must
be designed so that it does not automatically restart the machine/system after a power failure.

» Prevent unauthorized access or changes to the control system or software.

Documentation and Training

It is the responsibility of the machine/system designer to provide documentation on safety, operation,
maintenance and programming, along with training for all machine operators, maintenance technicians,
programmers, and other personnel who may have access to the machine. This documentation must
include proper lockout/tagout procedures for maintenance and programming operations.

It is the responsibility of the operating company to ensure that:
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Additional Equipment and Considerations

» All operators, maintenance technicians, programmers and other personnel are tested and qualified
before acquiring access to the machine or system.

» The above personnel perform their assigned functions in a responsible and safe manner to comply
with the procedures in the supplied documentation and the company safety practices.

« The equipment is maintained as described in the documentation and training supplied by the
machine/system designer.

Additional Equipment and Considerations

The Risk Assessment and the operating company's standard safety policies will dictate the need for
additional equipment. In general, it is the responsibility of the operating company to ensure that:

» Unauthorized access to the machine is prevented at all times.

« The personnel are supplied with the proper equipment for the environment and their job functions,
which may include: safety glasses, hearing protection, safety footwear, smocks or aprons, gloves,
hard hats and other protective gear.

o The work area is equipped with proper safety equipment such as first aid equipment, fire
suppression equipment, emergency eye wash and full-body wash stations, etc.

« There are no modifications made to the machine or system without proper engineering evaluation for
design, safety, reliability, etc., and a Risk Assessment.
Safety Information Resources

Additional SmartMotor safety information can be found on the Moog Animatics website; open the topic
"Controls - Notes and Cautions" located at:

https://www.animatics.com/support/downloads/knowledgebase/controls---notes-and-cautions.html

OSHA standards information can be found at:

https://www.osha.gov/law-regs.html

ANSI-RIA robotic safety information can be found at:

http://www.robotics.org/robotic-content.cfm/Robotics/Safety-Compliance/id/23

UL standards information can be found at:

http://ulstandards.ul.com/standards-catalog/

ISO standards information can be found at:

http://www.iso.org/iso/home/standards.htm

EU standards information can be found at:

http://ec.europa.eu/growth/single-market/european-standards/harmonised-standards/index_en.htm

Additional Documents

The Moog Animatics website contains additional documents that are related to the information in this
manual. Please refer to these lists.
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Related Guides

Related Guides
o SmartMotor™ Developer's Guide

http://www.animatics.com/smartmotor-developers-guide

o SmartMotor™ Homing Procedures and Methods Application Note

http://www.animatics.com/homing-application-note

o SmartMotor™ System Best Practices Application Note

http://www.animatics.com/system-best-practices-application-note

In addition to the documents listed above, guides for fieldbus protocols and more can be found on the
website: https://www.animatics.com/support/downloads.manuals.html

Other Documents
¢ SmartMotor™ Certifications

https://www.animatics.com/certifications.html

o SmartMotor Developer's Worksheet
(interactive tools to assist developer: Scale Factor Calculator, Status Words, CAN Port Status, Serial
Port Status, RMODE Decoder and Syntax Error Codes)

https://www.animatics.com/support/downloads.knowledgebase.html

» Moog Animatics Product Catalog

http://www.animatics.com/support/moog-animatics-catalog.html

Additional Resources

The Moog Animatics website contains useful resources such as product information, documentation,
product support and more. Please refer to these addresses:

» General company information:

http://www.animatics.com

e Product information:

http://www.animatics.com/products.html

e Product support (Downloads, How-to Videos, Forums and more):

http://www.animatics.com/support.html

» Contact information, distributor locator tool, inquiries:

https://www.animatics.com/contact-us.html
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Additional Resources

» Applications (Application Notes and Case Studies):

http://www.animatics.com/applications.html
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SmartMotor Overview

SmartMotor Overview

This chapter provides an overview of the design philosophy and functionality of the Moog Animatics
SmartMotor. It also provides information on SmartMotor features and options, and where to find related
documents and additional resources.

SmartMotor Introduction ... 15
SmartMotor Features and Options ... ... 15
Class B D-Style MOtOrS ... 16
Standard Features ... .. ... 16
Optional Features ... ... 17
Connectors and LED LOCAtIONS ... ... .. ... 17
FieldbUS O ptiONS . 18
CANopen Fieldbus ProtoCol ... . . 18
EtherCAT Fieldbus ProtoCol ........ ... ... e 18
PROFINET Fieldbus ProtoCol ... ... ... e 19
EtherNet/IP Fieldbus ProtoCol ........ .. ... ... 19

Dual Power Configuration ... .. 21
SmartMotor Theory of Operation ... .. 22

Moog Animatics Class 6 D-Style SmartMotor™ Installation and Startup Guide, Rev. F
Page 14 of 72



SmartMotor Introduction

SmartMotor Introduction

The Moog Animatics SmartMotor™ servo is an industrial servo motor with motion controller integrated into a
compact package. Its design is based on these objectives:

1. Reduce development time
2. Lower machine-production cost

3. Simplify the machine (design, build and support)

Class 6 D-Style SmartMotor with Industrial Ethernet and Inline Brake Options

The SmartMotor is powerful and unique because of its ability to control an entire machine. The combination
of programmability, networking, I/O and servo performance is unmatched. The SmartMotor brings savings
and value to the machine builder by removing complex and costly elements in the machine design, such as
PLCs, sensors, I/0 blocks, cabinets, etc.

SmartMotor Features and Options

NOTE: All specifications are subject to change without notice. Consult the factory for the latest
information.

The Class 6 D-style SmartMotor is available only in a D-style configuration. All SmartMotors offer these
features:

« Full floating-point math and trigonometric functions with 32-bit precision results

« Dual trajectory generators enabling relative and absolute position moves or velocity moves on top of
gearing or camming

« Advanced gearing allowing preset traverse and take-up winding parameters including dwells and
wrap counts

» Advanced camming including cubic spline interpolation and dynamic frequency and amplitude
changes. Add onto gearing for complex traverse and take-up winding patterns.

» Stand-alone, multi-axis linear interpolation with as many as 120 SmartMotors at a time

Moog Animatics Class 6 D-Style SmartMotor™ Installation and Startup Guide, Rev. F
Page 150f 72



Class 6 D-Style Motors

Virtual-axis control into camming through gearing, which enables stand-alone, multi-axis
coordinated motion

Programmable and non-programmable protection features (both hardware and software)

A note about SmartMotor part numbers:

The SmartMotor uses a coded part number, which contains characters that describe the motor number,
frame style and options. For details on decoding the SmartMotor part number, refer to the Understanding
SmartMotor Part Numbers document at this address:

https://www.animatics.com/support/downloads.knowledgebase.html

Class 6 D-Style Motors

The Class 6 SmartMotor is available in an D-style configuration.

Standard Features

All Class 6 D-style SmartMotors have these standard features:

Batteryless (and gearless) absolute multiturn encoder, no battery backup needed, see Batteryless
Absolute Multiturn Encoder on page 65

High density 26-pin (the "HD26") connector in a DA shell, supports additional /0 and more
communications options

Ten channels of expanded, industry standard 24 VDC I/O (I/O 0-9)
Dedicated Drive-Enable input and NOT-FAULT output

Single or dual (separated) drive and control power input, both are standard and enabled
automatically depending on power connection(s)

Differential encoder input for reduced interference from electrically noisy environments
105 °C upper operating temperature limit for higher torque output

LEDs: Bi-colored LED indicators to show error codes, provide network status and communications
activity

CAN over D-Sub (CDS) and 7W2 (CDS7) connectors
Communications: RS-232, RS-485, Combitronic, USB, Ethernet, CAN bus, with no loss in I/0

Upgraded processors (as compared to Class 5) with higher clock speeds, more RAM and EEPROM,
resulting in more space for more complex user programs, faster program execution, and built in
homing functions

SMI software available, optionally used for application development and debugging
I/0O support for Drive Enable, Position Limits and Fault status
Motor sample rate: 16 kHz
Position Capture Register from signal-ended, ground-referenced external input (non-differential)
External encoder input supporting either A-quad-B or Step-and-Direction modes of counting
e Machine Line Shaft Input support

» Maximum individual line frequency at either the A or B input is 1.5 MHz
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Optional Features

All firmware options include:

» Modbus Remote Terminal Unit (RTU) Follower (RS-485 COM 1), see the SmartMotor™ Modbus
RTU Guide

+ DMX Follower (RS-485 COM 1), see the SmartMotor™ DMX Guide

Optional Features
These Class 6 D-style features are optional:
NOTE: These options can be ordered individually or combined.
« Inline brake option (available on all frame sizes)

« Industrial Ethernet with dual-port switch (available on all frame sizes) — see the available fieldbus
communications protocols below

« "DT" high torque option, applies to SM23166, SM23266, SM23376, SM34166, SM34266 models -
contact Moog Animatics for details

» Shaft options such as 1 or 2 flats, or keyed - contact Moog Animatics for details

These fieldbus communications protocols are available on the Class 6 D-style motors.
NOTE: These fieldbus protocols require the Industrial Ethernet option.

« EtherNet/IP (-EIP) option

» EtherCAT (-EEC) option

+ PROFINET (-EPN) option
The Class 6 D-style motors are available in these NEMA frame sizes:

« NEMA 17

 NEMA 23

« NEMA 34

For additional information on SmartMotor features, specifications, torque curves and more, see the
corresponding SmartMotor product page for your motor. SmartMotor product pages are available from the
Products menu on the Moog Animatics website.

Connectors and LED Locations

The next figure shows the connector and LED location for the Class 6 D-style SmartMotor. For details on
the motor connectors, see you and your familyConnecting the System on page 34. For details on the LED
functions, see Understanding the Status LEDs on page 46.

CAUTION: For Class 6 D-style SmartMotors, pins 11 and 12 of the 26-pin D-sub port

are intended for control power only. Attempts to power a motor through those pins as
main servo drive power could result in immediate damage to the electronics and will
void the warranty.
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Fieldbus Options

26-Pin D-Sub /0 (HD26)
Power/Servo LED

7-Pin Combo D-Sub
Power & 1/0 (7W2)

Trajectory LED

Class 6 D-Style Motor Connectors and LEDs

Fieldbus Options

This section details the Fieldbus communications protocol options that are available on Class 6 D-style
SmartMotors.

CANopen Fieldbus Protocol

NOTE: This protocol is a standard feature on the Class 6 D-style SmartMotor.

The CANopen fieldbus protocol provides these features:

Basic motion commands available through the CiA V4.02 specification

Ability to read/write SmartMotor variables

Use of onboard I/0 through CANopen, SmartMotor programs or serial commands
Ability to run 1000 SmartMotor subroutines through CANopen

Online diagnostics of the SmartMotor through SMI software and serial connection
Logical addressing for 127 nodes

User program status/interrupts can be triggered by receive PDOs

Baud rates of 20 Kbps, 50 Kbps, 125 Kbps (default), 250 Kbps, 500 Kbps and 1 Mbps

Expanded I/O capability allows the SmartMotor to interface with standard CiA 301 CANopen devices
and function as the 1/0 device CAN bus controller (i.e., no external bus controller is needed). For
more details, see the SmartMotor™ Developer's Guide. For CANopen object descriptions, see the
SmartMotor™ CANopen Guide.

NOTE: For the Class 6 D-style SmartMotor, there is no separate CAN connector on the back of the
motor. CAN bus connections are available on both the 7-pin and HD26-pin connectors. For details, see
CDS Schematic on page 39.

For more details, see the SmartMotor™ CANopen Guide.

EtherCAT Fieldbus Protocol

NOTE: This fieldbus protocol is optionally available on Class 6 D-style motors.
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PROFINET Fieldbus Protocol

The EtherCAT fieldbus protocol provides these features:

Command/Response Codes for SmartMotor commands

CiA 402 Motion Modes: Profile Position (PP), Profile Velocity (PV), Torque (TQ), Cyclic Sync
Position (CSP), Cyclic Sync Velocity (CSV), Cyclic Sync Torque (CST)

Dynamic PDO mapping

Configurable Sync Manager 2 and 3 assignment
DC-sync Subordinate mode with SYNCO and SYNC1
DC-sync follower

Selectable Homing modes (with or without index pulse)
Selectable Interpolation modes (spline or linear)

Touch Probe function allows the motor's position to be captured on a specific event

For the EtherCAT connector diagram and pinouts, see Industrial Ethernet Network on page 43.

For more details, see the Class 6 SmartMotor EtherCAT Guide.

PROFINET Fieldbus Protocol

NOTE: This fieldbus protocol is optionally available on Class 6 D-style motors.

The PROFINET fieldbus protocol provides these features:

Command/response codes for SmartMotor commands
Use of on-board I/O through PROFINET, SmartMotor program, or RS-485 commands

The Moog Animatics communications profile over PROFINET is intended to integrate well with a
PLC that continuously transmits and receives cyclic data; the command and response codes
achieve this through a handshaking mechanism

For the PROFINET connector diagram and pinouts, see Industrial Ethernet Network on page 43.

For more details, see the Class 6 SmartMotor™ PROFINET Guide.

EtherNet/IP Fieldbus Protocol

NOTE: This fieldbus protocol is optionally available on Class 6 D-style motors.

The EtherNet/IP fieldbus protocol provides these features:

Access to unique SmartMotor commands and parameters.
Use of on-board I/0O through EtherNet/IP, SmartMotor program, or RS-485 commands

The Moog Animatics communications profile over EtherNeV/IP is intended to integrate well with a
PLC that continuously transmits and receives cyclic data (implicit messaging); the command and
response codes achieve this through a handshaking mechanism

Certain configuration data is held in nonvolatile storage in the SmartMotor; therefore, the motor data
EEPROM must be correctly initialized before EtherNet/IP operation

Supports extended function CIP Position Controller Device

Supports Modbus TCP/IP, see the Class 6 SmartMotor™ Modbus TCP/IP Guide
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EtherNet/IP Fieldbus Protocol

» Supports Ethernet Serial Encapsulation, see the Class 6 SmartMotor Ethernet Serial Encapsulation
Guide

» Control modes for Profile Torque, Profile Velocity and Profile Position modes
» Change Dynamic - motion profile changes on the fly
« Implicit exchange access to many SmartMotor parameters

» Supports the SMI software Find/Detect operations over Ethernet — the SmartMotor must be pre-
viously configured (through COM or USB) with a valid IP address

For the EtherNet/IP connector diagram and pinouts, see Industrial Ethernet Network on page 43.

For more details, see the Class 6 SmartMotor EtherNel/IP Guide.
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Dual Power Configuration

Dual Power Configuration

The Class 6 D-style SmartMotor's hardware dual power configuration allows the controller and drive
amplifier to be powered from separate DC power supplies (see the next figure).

NOTE: I/0 outputs cannot be powered from the 7W2 connector.
This configuration provides these advantages:
» Controller can be powered from a +24 VDC (£20%) 32 VDC max. power supply
» Load surges will not cause a power surge on the controller

NOTE: All Class 6 D-style SmartMotors are designed to allow the use of separate drive and control
power supplies. No special ordering option is needed for those SmartMotors.

The next figure shows the connectors used for the dual power configuration.

Control power supplied to this connector
(+24 VDC (x20%) 32 VDC max.)

Drive Amp power supplied to
this connector (24-48 VDC()

NOTE: These motors can operate on
Drive Amp power down to +20 VDC,
but it is not recommended due to
greatly reduced performance — opti-
mum performance is achieved at 48
VDC.

D-Style Dual Power Configuration Drive and Control Power Connections

Although you can supply the control and drive power from one power supply, you will only get the full
benefits and maximum protection by using separate power supplies, as noted in the previous figure.
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SmartMotor Theory of Operation

The Moog Animatics SmartMotor is an entire servo control system built inside of a servo motor. It includes a
controller, an amplifier and an encoder. All that is required for it to operate is power and either an internal
program or serial commands from outside (or both). To make the SmartMotor move, the program or serial
host must set a mode of operation, state a target position with/or a maximum velocity at which to travel to
that target, and a maximum acceleration. After these three parameters are set, the two limit inputs are
pulled high or deactivated, and the Drive Enable input is satisfied, a "Go" command starts the motion
profile.

The core functional areas of the SmartMotor are:
» Motion Control Functions (see Motion Details in the SmartMotor™ Developer's Guide)

» System Control Functions (see Program Flow Details and see System Status in the SmartMotor™
Developer's Guide)

o Communication Functions (see Communication Details in the SmartMotor™ Developer's Guide)

e 1/O Functions (see I/O Control in the SmartMotor™ Developer's Guide)
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SmartMotor Theory of Operation

The next block diagram illustrates the relationship between the functional areas in the SmartMotor.

VI= AT= DT= G X OFF 5 .
PT= PRT= ADT= :
l ! Control
‘//‘\ * KV : on/off
Trajectory 1 M !
4 Accel |xKA |
mp | mv | mp ! K11 [KPT
: Torque J
comman
. RPC P e*KP E Currenlt
Trajectory 2 O= @ . I | contro
mc | MFR | Msk - !
ReAL [filter] | — |
KS D |kp* & :
GEARING IS NOT ' Current
SUMMED WITH
¢ Ca? CAMMING; IF CAM y sensors
unction' | LENGTH IS 0, THERE o) Mot
IS NO MOTION! - o PWM o
J) % % Encoder
External RCTR(0) N
INTERMEDIATE
jacetis Encoder
Trapezoidal m:ﬁg 'EE' Commutation
MFSLEW O
Move Profile| yre &
SOURCE
COUNTS N
Internal a0 SRC(2) —
Clock: SRC(1)
1 tick per SRC(0) —
PID cycle [x-1}— SRC(-1)—
Gl — SRC(-2)—
NOTES:

1. MFMUL and MFDIV commands do not have an effect on dwell time or distance. Dwell is strictly based on raw controller encoder counts selected by the

SRC() command specifying internal virtual or external controller count source.

2. When feeding a Cam table with a gearing profile, changes to MFMUL and MFDIV will affect the time it takes to move through a Cam table but will not

affect dwell time, as specified in the previous note.

SmartMotor Theory of Operation Diagram
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Getting Started

This chapter provides information on getting started with your SmartMotor.

Unpacking and Verifying Your Shipment ... ... 26
Installing the SMI Software ... 26
Installation Procedure ... ... ... 26
Installation Verification ... .. ... 29
Accessing the SMI Software Interface ... 29
Understanding the Power Requirements ... 31
SmartMotor Power Requirements . .. 31
CPU, I/0 and Communications POWET ... .. ... ... e 32
CPU Power ReqUIremMENtS ... 32

/O Power ReqUIremMENtS .. . 33
Communications Power Requirements ... ... . 33
Drive Enable INpUt .. 33
you and your familyConnecting the System ... ... ... .. 34
Minimum ReqUIrEmMENtS . 34
Connectors and PiNOULS ... . ... 35
D-Style ConnectioNns AtA GIANCE ... ... 35
Demo or Development System ... 36
RS-232 Through US B ... . e 36
Adding a USB to Serial Adapter ... . 36
RS-232 with Protective ShUNt ... . ... 37
RS-232 Multidrop with Add-A-Motor Cables ... ... . 37
USB t0 HD26 CONNECIOT ... .. i 38
Dual Power Configuration ... .. . 38
CDS SChemMaLC ... ... 39
CDS 0nthe HD26 CONNECIOT .. ... ... .ot 39
CDS onthe 7W2 ConneCtor (CD ST ) ... 40
Industrial Ethernet Network ... .. 43
Minand Max Cable Length ... ... 44
Ethernet Cables ... .. ... 45
Understanding the Status LEDS . ... ... .. . 46
Detecting and Communicating with the SmartMotors ... 46
Understanding the Detection and Configuration Options ................. ... ... . . . 47
Using the Find Motors Button ... . . 47
Using the Detect Motors Feature ... .. .. . 50
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Checking and Clearing the Status Bits ... 52
POIlNG the MOtOr ... 53
Clearing the Overtravel Limits and Fault Bits ........ ... ... . ... . . 54

Moving the SmantMotor .. . 55
Making the Motor MOVe ... 55
Setting and Reporting TOTQUE ........ ... e 56

Checking the Motor Position ... ... . . 57
Viewing the Motor Position with a Report Command ... ... . 57
Viewing the Motor Position with the Motor View Tool ... ... . . 57
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Unpacking and Verifying Your Shipment

Unpacking and Verifying Your Shipment

Your Moog Animatics SmartMotor and accessories are carefully assembled, tested, inspected and packed
at the factory.

When you receive your shipment, you should:

» Visually inspect all shipping containers for visible signs of shipping damage. If you see damage,
please notify your carrier and then contact Moog Animatics to report the problem.

» Carefully unpack each component and verify the part number with your order. If there are any
differences or missing items, please contact Moog Animatics so that the shipment can be corrected.

» Keep all boxes and packing materials. These may be needed for future storage or shipment of the
equipment.

Installing the SMI Software

The SmartMotor Interface software (SMI software) provides a convenient user interface for programming
the SmartMotor. Before you can use the SMI software, it must be installed on a Microsoft Windows PC.

The SMI software is distributed on CD-ROM or USB stick, and is also available as a download from the
Moog Animatics website. To download the latest version of the SMI software, use this address:

http://www.animatics.com/smi

Then scroll to the bottom of the page and click the Free Download button.

FREE DOWNLOAD

SMI Download Button

The installation package is downloaded to your system.

NOTE: The SMI software requires Microsoft Windows XP or later.

Installation Procedure

NOTE: Depending on the SMI software version and SmartMotor model being used, the software
version and motor information may be different on your screens.

To install the SMI software:
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Installation Procedure

1. Double-click the executable package (.MSlI) file to begin the installation. In some versions of
Microsoft Windows, you may receive a security warning message about running the file. You can
ignore this message.

If this is a new installation, go to the next step.

If this is an upgrade to a previous installation, you will see the window below. Select Remove, click
Next and remove the existing software from your PC using the instructions.

ﬁ SmartMotor Interface Setup

Application Maintenance
Select the maintenance operation to perform,

Version 3.0.0.70 (with IntegMotorinterface 2.2.3.17)

() Modify
=g Change which applization features are installed. Dizplays the
@g Select Featurez dialog, which lets you configure individual features.
=
) Repair
Reinztall missing or cormupt files, registry keys, and shortouts,
@T Preferences stored in the registiy may be reset to default values.
i=
® Remove
; |Irinztall Smartkdator Interface from thiz computer.
-‘
E D‘i

Wize Inztallation Wizard [R]

< Back Cancel

After removing the existing software, restart the installation process.
NOTE: All personal settings and user files will be retained.

2. Click Next to proceed. The Installation Configuration page opens.

15 SmartMotor Interface Setup — it

Installation Configuration

Set property values used for configuring the installed application.

Version 3.0.0.70 (with IntegMotorinterface 2.2.3.17)

Select desired language: E malizh ol

Wise Installation Wizard®
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Installation Procedure

3. Click Next to proceed. The SMI software installation wizard starts and the Welcome page opens.

jﬁl SmartMotor Interface Setup - d

Welcome to the SmartMotor
Interface Installation Wizard

It iz strongly recommended that you exit all Windows programs
before rinning thiz zetup program.

Click Cancel to guit the setup program, then close any programs
wou have running. Click Mest to continue the inztallation.

WARMIMG: Thig program iz protected by copyright law and
international treaties.

|Inauthaorized reproduction or diztribution of thiz program, or any

portion of it, may result in severe civil and criminal penalties, and
will be progecuted to the maximum extent poszible under law,

< Back Cancel

4. After you have finished reviewing the welcome information, click Next to proceed. Use the on-screen
instructions to complete the SMI software installation.
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Installation Verification

5. When the installation has completed, the installation status message page opens, as shown in the
next figure. Click Finish to complete the installation and close the installation wizard.

jﬁl SmartMotor Interface Setup - d

SmartMotor Interface has been
successfully installed.

Click. the Finish buttan to exit thiz inztallation.

< Back Cancel

NOTE: After the software is installed, be sure to restart your computer before running the SMI software.

Installation Verification

To verify the installation, navigate to the C:\Program Files (or folder C:\Program Files x86) folder. You
should see these folders:

4 Animatics

SMIE

Accessing the SMI Software Interface

The SmartMotor Interface software (SMI software) communicates with a single or series of SmartMotors
from a Windows-based PC and gives you the capability to control and monitor the status of the motors. The
SMI software also allows you to write programs and download them into the SmartMotor’s long-term
memory.

NOTE: Every SmartMotor has an ASClI interpreter built in. Therefore, it is not necessary to use the SMI
software to operate a SmartMotor.

To open the SMI software, double-click the SmartMotor Interface shortcut on the Windows desktop.

o
F1=
SmartMotor
Interface

SmartMotor Interface Shortcut
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Accessing the SMI Software Interface

Optionally, to open the SMI software from the Microsoft Windows Start menu, select:
Start > All Programs > Animatics > SMI3 > SmartMotor Interface

The SMI software interface opens, as shown in the next figure.

SmartMotor Interface - [SMI1] = | = ]

Menu bar _ |[File Edit View Communication Compile Tocls Window Help
Toolbar —— L= d S EE N AR BB rm o F W

. /[%‘ Com | Ethemet | USE | C&N Channel 0 | . “:jl ‘ =l
C(?nﬁguratlon g I Oper [l Moters JlEnmS,HEDD,F\S#EE,Eh},EN}/
window | Send

/‘— Lo CAN Channel 0 (125000 bps)
Terminal

window /

Program /

editor

Location Description

Information
window

For Help, press F1 Yersion: 5.0.2 NUM Lnl, Coll
L

SMI Software Interface

NOTE: In addition to the software information in this section, there is context-sensitive help available
within the SMI software interface, which is accessed by pressing the F1 key or selecting Help from the
SMI software main menu.

These are the primary features in this interface:

« Menu Bar: All of the windows and functions of the SMI software can be accessed through the menu
bar. Many of these are also accessible through the icons on the toolbar.

» Toolbar: The toolbar contains a collection of icons for accessing the primary features of the SMI
software. Depending on the current state of the SMI software and the currently-active window, some
toolbar buttons may be disabled.

« Configuration Window (far-left window): This window is used to display the current communication
and detected motor configuration when no project is open, or the communication and motor
configuration defined in an open project.

o Terminal Window (middle window): This window is used to communicate with SmartMotors (for
example, issue single-line commands to one or all motors). The response (if any) is also shown in
this window.

 Information Window (lower window): This window is used to display the results of user operations.

» Program Editor (far-right window): This window is used to manage, edit and print user programs.
Most of the procedures for using the editor should seem familiar if you have used other Windows-
based text editors.

For more details about these items, see the SMI software online help, which can be viewed in SMI by
pressing F1 or selecting Help > Contents - SMI Software Help.
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Understanding the Power Requirements

This section describes the power requirements for Class 6 D-Style SmartMotor power, CPU power, I/O
power and Communications power.

SmartMotor Power Requirements
CAUTION: If power is reversed on any standard SmartMotor, immediate damage
WILL occur and the SmartMotor will no longer operate.

Requirement:

For Class 6 D-Style SmartMotors, there are two options: 1) power the entire motor (drive and control) from
the main input on the 7W2 connector, or 2) the recommended "dual power" method, power the drive stage
through the 7W2 connector and power the controller through the HD26 D-sub connector. Refer to the next
figure. For more details on the dual power configuration, see Dual Power Configuration on page 38.

Single Power Supply Dual Power Supplies
Powers Drive and Controller Maintains Controller if Drive Power is Cut

SmartMotor D SmartMotor
ual
D-sub_

Controller guogvpel;/ -‘
Drive gl?;vpel;/ (®7| Drive

7W2

D-sub_

; ||
ingle

p

el oo

7W2

Single vs. Dual Power Configuration

CAUTION: Control power for Class 6 D-Style motors must be nominal 24 VDC
(¥20%). They are not rated for 48 VDC.

Control power requires nominal 24 VDC (£20%), do not exceed 32 VDC; motor power requires from 24
VDC to 48 VDC, do not exceed 48 VDC. Also, note that:

« Ifl/Os are used, the control power pins must be supplied with power, as those pins provide signal
power for the 1/0, see I/O Power Requirements on page 33.

« If the brake option is installed, brake power is supplied by the drive power input on the 7W2
connector. Therefore,

« If drive power is lost, the brake will de-energize and hold the shaft.

« If control power is not supplied on the HD26 connector, but is supplied through the 7W2
connector, the brake will still work.

NOTE: These motors can operate on power down to +20 VDC, but it is not recommended due to greatly
reduced performance -- optimum performance is achieved at 48 VDC.

Details: Large SmartMotors can draw high current. Therefore, heavy gauge wire is required to connect the
large motors.

Voltages below 18 VDC could cause a brownout shutdown of the CPU, or what would appear as a power-
off reset, under sudden load changes.

When relying on torque/speed curves, pay close attention to the voltage on which they are based.
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CPU, I/0 and Communications Power

During hard, fast decelerations, a SmartMotor can pull up supply voltages to the point of damage if a shunt
resistor pack is not used. Protective shunts are available from Moog Animatics.

CAUTION: Many vertical applications and applications with hard, fast decelerations

require shunts to protect the SmartMotor from damage. Note that shunts should
always be placed between the motor input and any disconnect or E-stop relay to
protect the motor when power is off or E-stop relay contacts are open.

Special care must be taken when near the upper voltage limit or in vertical applications that can back-drive
the SmartMotor. Gravity-influenced applications can turn the SmartMotor into a generator and back-drive
the power supply voltage above the safe limit for the SmartMotor. Many vertical applications require a shunt
to protect the SmartMotor from damage. Protective shunts are available from Moog Animatics.

CPU, I/0 and Communications Power

CAUTION: The maximum allowed supply voltage is 32 VDC. Voltages greater than
the maximum value will damage the equipment.

The CPU can be powered directly from the drive (single power configuration), or it can be powered
separately from the drive (dual power configuration). For details, see the discussion earlier in this topic, and
also see Dual Power Configuration on page 38.

For dual power configurations, the HD26 control power input pins can draw 24 VDC @ 650 mA in total
(CPU power and I/0O power), see the next two sections for details. If the Ethernet option is included, it uses
an additional 100 mA, see the next figure.

NOTE: If control power is not supplied on the HD26 input (pin 11), outputs will not be able to be driven.
However, all inputs can still be detected.

Control Power Example

Controller driving four outputs
<=200 mA each, 400 mA total
Control Power Input Controller
250 mA > Outputload=200 mA
min=250 mA
max =750 mA » Output load =100 mA
» Output load =50 mA
» Output load =50 mA
Ethernet Option NOTE: Total output load
100 mA not to exceed 400 mA

Control Power Example with Ethernet Option and Four 100 mA Outputs

CPU Power Requirements

For dual power configurations, where the controller and drive are each powered separately, the user-
supplied 24 VDC controller power supply should be capable of handling up to 6 watts (250 mA) for the CPU
alone; see the next section for additional I1/0 power requirements.

Requirement: Nominal 24 VVDC (range 18-32 V) @ 250mA must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input (pin 11) on the HD26-pin D-sub connector.
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I/O Power Requirements

I/0 Power Requirements
Requirement: Nominal 24 VVDC (range 18-32 V) @ 400 mA must be supplied. Do not exceed 32 VDC.
Details: Power is supplied from the "control" power input (pin 11) on the HD26-pin D-sub connector.
NOTE: This I/O is not isolated from the CPU's power supply and the motor drive.
NOTE: Unlike the M-style, the D-style does not provide 24 VDC Control/IO output power.
Specifications:

NOTE: All specifications assume nominal 24 VDC (range 18-32 V) Control power. The maximum
allowed supply voltage is 32 VDC. Voltages greater than the maximum value will damage the motor.

Input Pins Electrical Specification:

 Input Voltage Low Level Threshold: 3.6 V maximum
 Input Voltage High Level Threshold: 6.0 V minimum

Output Pins Electrical Specification:

¢ Output Loading:

¢ Nominal load: 200 mA each

¢ Maximum load: not to exceed 400 mA total (all outputs combined)
¢ Output voltage: 23 V maximum load

Communications Power Requirements
Requirement: Nominal 24 VDC (range 18-32 V) must be supplied. Do not exceed 32 VDC.
Details: Power is supplied from the "control" power input (pin 11) on the HD26-pin D-sub connector.

NOTE: The RS-485 signal is not isolated from the CPU's power supply or the motor drive.

Drive Enable Input

The Drive Enable input (HD26, pin 8) must be connected and activated with 24V. For the input location, see
Connectors and Pinouts on page 35.

Moog Animatics Class 6 D-Style SmartMotor™ Installation and Startup Guide, Rev. F
Page 33 of 72



you and your familyConnecting the System

you and your familyConnecting the System

The topics listed below show system connections and cable diagrams for typical Class 6 D-style motor
installations. For connector specifications, 1/0 and Channel information, and example I/O connections, see
Connectors, Pinouts and Examples on page 59.

For Class 6 D-style motors:

» Connectors and Pinouts on page 35

o Demo or Development System on page 36

o RS-232 Through USB on page 36

» RS-232 with Protective Shunt on page 37

o RS-232 Multidrop with Add-A-Motor Cables on page 37
» USB to HD26 Connector on page 38

« Dual Power Configuration on page 38

As you can see, many configurations are possible.

« If you are installing one of these typical configurations and Moog Animatics-supplied cables, simply
use the connection information in this section.

« If you are using your own cables or a non-typical configuration, review the information in this section
and also see Connectors, Pinouts and Examples on page 59.

Advanced communication information is available in Communication Details in the SmartMotor™
Developer's Guide.
Minimum Requirements
At minimum, you will need these items:

1. A Class 6 D-Style SmartMotor

2. A computer running Microsoft Windows and the SMI software
3. ADC power supply and power cable for the SmartMotor
4

. A data cable to connect the SmartMotor to the computer’s serial port or through a USB to serial
adapter, see D-Style Connections At A Glance on page 35.

OR a USB cable to connect the SmartMotor to the computer's USB port, see USB to HD26
Connector on page 38,

OR if your SmartMotor is equipped with the Ethernet option, a Cat 5 (or better) Ethernet cable to
connect the motor to the computer's Ethernet port, see Industrial Ethernet Network on page 43.
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Connectors and Pinouts

Connectors and Pinouts

The next figure provides a brief overview of the connectors and pinouts available on the D-style
SmartMotors. For full details, see Class 6 D-Style Connector Pinouts on page 60.

HD26-Pin D-Sub 1/0
Toprow: 9 8 76 543 21
Mid row: 18 17 161514 13 12 11 10

7-Pin Combo D-Sub
Power & I/O

Btmrow: 262524 2322212019
PIN | DESCRIPTION PIN | DESCRIPTION PIN | DESCRIPTION
1 | INO GP, also Analog Input 14 | EncoderA- input Al | MainPower +20-48VDC
2 | IN1GP, also Analog Input 15 | EncoderB-input A2 | Common Ground
3 | IN2 Positive Limit or GP 16 | EncoderB- input (req'd. POWER Ground)
4 | IN3 Negative Limit or GP 17 | CAN High (alsoon7W2) 1 | CAN Low (also on HD26)
5 | IN/OUT4 GP or Ext.Enc.IndexCapt| | 18 | CAN Low (alsoon7W2) 2 | CAN High (also on HD26)
6 | IN/OUT5 GP or Int. Enc. Index Capt. 19 | RS-485B(COMCH1) 3 RS-232 Transmit (COM CH 0)
7 | IN6, G cmd or Homing Input 20 | RS-485A(COMCH1) 4 | RS-232 Receive (COM CH0)
8 | IN7,Drive Enable Input (Dedicated)| | 21 | nc 5 | SIGGround
9 | IN/OUTS, GP or Brake Line Output 22 | nc.
10 | IN/OUT9, GP or Not Fault Output 23 | USB 45V Bus
11 | 24 VDC Control Power 24 | USBD+
12 | Control Power Rtn (Grd, Common) 25 | USBD- )
13 | Encoder A+input 26 | Ground, Common Trajectory OUT* _IN* PWR/Servo

LED | LED
Optional Dual-Port Industrial Ethernet
*IN/OUTappliesonlytoEtherCATnetworks

NOTE: The dual power configuration is recommended. For details, see Dual Power Configuration on
page 38.

D-Style Connections At A Glance

The next figure provides a quick overview of the cables and connections for the Class 6 D-style motor.

NOTE: The USB connection on CBLHD26-ASM is meant only for programming from the SMI software;
it is not recommended for running the motor.

CBLHD26-ASM

Connector assembly from Moog Animatics;

CAN bus cable is customer supplied
Internal jumper
CAN TERM*

(under cover)

*When ON, activates
120 ohm terminator

3¢ o
USB A Male to Micro USB
(Customer supplied)

OR

USB to Serial Adapter
(Customer supplied)

CBLSM1-xM

ﬁ824V8AG-110
or PS42V6AG-110

SM23166D
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Demo or Development System

Demo or Development System

CAUTION: This configuration is designed for development, training or demo
purposes only. It is not intended for use in an industrial (manufacturing) environment.

CBLSM1-DEMO
j/ PWR116V

-

RS-232 Through USB

Customer Supplied
USB to Serial Adapter CBLSM1-xM

-E——g [B-

PS24V8AG-110
or PS42V6AG-110—

Adding a USB to Serial Adapter

For this application, the customer must provide a USB to Serial (FTDI chipset) adapter, which is used on
PCs that don't have a built-in serial port. The adapter allows you to connect from an available USB port on
the PC to the serial interface on the SmartMotor. The adapter simply connects between the USB port and
the serial cable, as shown in the previous figure. These adapters are readily available from computer
supply stores and online shopping websites.
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RS-232 with Protective Shunt

RS-232 with Protective Shunt

CBLSM1-xM

B
Bl

CBLDC1

SHUNT42V100W
or SHUNT42V200W
r

PS24V8AG-110
or PS42V6AG-110

RS-232 Multidrop with Add-A-Motor Cables

CBLSM1-xM CBLSMADD-xM

PS24V8AG-110 or
7/ PS42V6AG-110
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USB to HD26 Connector

USB to HD26 Connector

NOTE: The USB connection on CBLHD26-ASM is meant only for programming from the SMI software;
it is not recommended for running the motor.

As shown in the pinout diagram (see page 35), the HD26 connector has pins available to support a USB
connector attached to the end of a cable from those leads. When that is installed, a USB port on the host
computer can be used to communicate directly with the SmartMotor without need for a USB to serial
adapter. The SMI software provides direct support for that communication method. However, the

USB connection is meant for programming only and is not recommended for running the motor.

The CBLHD26INT connector (see the next figure) incorporates a Micro USB port for direct connection of a
customer-supplied USB cable along with a 120 ohm terminating resistor, in the form of a jumper located
under the cover, that can be switched in/out as needed.

CBLHD26-ASM

Connector assembly from Moog Animatics;

CAN bus cable is customer supplied
Internal jumper

CAN TERM*

(under cover)

*When ON, activates ®

120 ohm terminator @ 88

USB A Male to Micro USB
(Customer supplied)

USB Connection to HD26 Cable

Dual Power Configuration

The dual power configuration, a standard feature on the Class 6 D-style motor, allows the controller and
drive amplifier to be powered from either a single or two separate DC power supplies. It is highly
recommended to use the dual power configuration.

Single Power Supply Dual Power Supplies
Powers Drive and Controller Maintains Controller if Drive Power is Cut
SmartMotor Duol SmartMotor

D-sub_ D-sub |

Single 4 I@I gl?;\lpel; -‘
P - .
soppy [ CEP>{ orive b DY)

7W2 7W2

Single vs. Dual Power Configuration

NOTE: For the Class 6 D-style motor, if only one power supply connection is used, it must be through
the Drive Power input, pins A1 and A2, on the 7W2 connector, which will also internally supply power to
the motor's controller. User outputs will not operate, but inputs will operate. When separate power
supplies are used, internal circuitry prevents their positive rails from shorting together.
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CDS Schematic

CN2: 26-PIN D-SUB
PIN# | NAME
1 o

10
11| CONTROL PWR

12 | CONTROL PWR GND
13

olplolo

26 o

CN1: 7-PIN COMBO
PIN#% | NAME

1| CANLOW

2| CANHIGH

3 |RS-232 TRANSMIT
4

5

RS-232 RECEIVE
SIG GND

ololofo]o

A2 | DRIVE PWR GND

Q

Drive Amp Power Supply: A1_| DRIVEPWR °f
48 VDC** _‘
* o—
L1 o—o]r/oT——o DRIVE PWR o—+ Koo
AC * Y

L2 ._O]T/OT__O DRIVE PWR GND O——

CONTROL PWR GNDo—{=

CONTROL PWR O

T

NOTES:
* Could be cascaded relays without timer
** Typical DC voltage levels

Control Power Supply:
24 VDC**

Protective shunt should be placed between E-stop and motor drive power
input to suppress Back EMF.

24 \VDC
Optional shorting of motor input on dropped drive power provides the most
E-Stop protection against Back EMF, and unintended freewheel motion, by employ-
Switch ing dynamic braking to stop the motor.
Relay T is time-delay open; relay K is immediate open; relay K must close
T K <— pefore relay T to avoid any damage to relay K from SmartMotor in-rush currents.
GND This circuit is recommended for smoother startup of large switch-mode sup-

plies where surge currents may cause noise issues.

NOTE: All Class 6 D-style SmartMotors are designed to allow the use of separate drive and control
power supplies. No special ordering option is needed for those SmartMotors.

CDS Schematic

This section provides schematics for wiring a Class 6 D-style SmartMotor through the CDS CAN
connection.

NOTE: CDS and CDS7 are included on all Class 6 D-style SmartMotor products.
CDS on the HD26 Connector

As a standard feature, the Class 6 D-style SmartMotor provides a CDS CAN connection allowing CAN bus
network wiring through the HD26 connector (26-pin D-sub I/0O connector shown in the next figure). This
eliminates a CAN connector on the back of the motor, leaving it free for other purposes, like the dual-port
Industrial Ethernet option. The D-style motor with the CDS CAN connection can be used as the terminating
node. To enable this, a 120 ohm terminating resistor (shunt) must be placed across pins 13 and 14. For
details, see the next figure.

NOTE: Terminating resistors (shunts) must always be used at both ends of a CAN bus network.
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CDS on the 7W2 Connector (CDS7)

HD26-Pin D-Sub I/O

Toprow: 9 8 76 5 43 21
Mid row: 18 17 16 15 14 13 12711 10
- )
e
. 1 ——
B p— o Motor as Terminating Node
/O Connector AADT 2 120 Ohm Terminator Shield Drain
Pin Numbers RS =
PIN_| DESCRIPTION | | O O / o _
17 | CAN High ) _— I AP 17 CAN High
18| CAN Low ("m“’k g 18 < 18 CAN Low
All other pins are as o o [}
previously shown. ©) \ O o
Trajectory ' Power/Servo ca % ™
LED (Bt) LED .
™~
[P | \ HW
120 Ohm \ 120 Ohm
Terminator Terminator

| | | | |
“ ‘ ‘ ‘ ‘ ‘ ‘ 12 Shield Drain
: A M A M Lol 17 CAN High
- ND DW - - - = 18 CAN Low

D] 26-pin D-sub Male 26-pin D-sub Male (D D} 26-pin D-sub Male (D

NOTE: A terminating resistor (shunt) or internal jumper on CBLHD26-ASM is required at each end
of the bus. Bus must be multi-drop as shown, not a star network. 24V CAN bus power connection is
not required at the motor.

Schematic for CDS Option, D-Style SmartMotor Used as Terminating Node

CDS on the 7W2 Connector (CDS7)

CAUTION:
If you are using the blue-overmolded Add-A-Motor cables (CBLSMCDS-xM) with CAN

bus already in them:

1. Do not create a parallel path between the same motors on the 26-pin (HD26) D-sub
connector, as that will cause impedance issues.

2. Any CAN nodes other than SmartMotors should be placed at the beginning and/or
end of the SmartMotor chain using the 26-pin (HD26) D-sub connector. Do NOT
"branch" to them from that connector in the middle of the SmartMotor chain. Branching
is not allowed on the CAN bus.

3. Be aware of CAN signal wires being present or not in the incoming power/signal
cable to the first 7W2 connector. If also using the 26-pin (HD26) D-sub connector to
access the CAN signals, then this could form an unintended branch.

For more information on CAN best practices, visit CAN in Automation at www.can-

cia.org.

Alternatively, CDS7 on the Class 6 D-style SmartMotor allows CDS to be wired through pins 1 and 2 of the

7-pin D-

Sub (7W2) connector as shown in the next figure. The wiring is accomplished through the use of a

single Add-A-Motor cable that carries Power, RS-232, and CAN bus to the next motor in the chain. This

method

allows pins 13 and 14 on the 26-pin D-sub connector to be used as an easy terminating point on the

last motor by simply placing a 120 Ohm terminating resistor (shunt) across those pins OR installing the
Pass-Thru Terminator on that connector.
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CDS on the 7W2 Connector (CDS7)

This design not only greatly simplifies motor installation, but also does the same for CAN bus addressing.
With CDS7, the SmartMotor is the first and only single-cable, point-to-point integrated motor to have both
motor-to-motor full communications and control capability, and only single-cable, point-to-point for both
power and communications in general.

As aresult:

» When you order the Class 6 D-style SmartMotors and CDS7 Add-A-Motor cables, you get prewired,
instant, full-network capability, and those networked motors are auto-detectable directly from SMI.

» This allows for auto-addressing and ease of reconnection at the next power up.

» Unlike competitive CANopen devices, the CDS7 SmartMotors do not require single-node power up
to set addresses. You can power up all at once, have SMI detect them and set all motor CAN bus
addresses in a single line of code. For details, see Detecting and Communicating with the
SmartMotors on page 46.

CDS7 is fully backward compatible with the wiring method described in the previous section. Therefore, all
Class 6 D-style SmartMotors can be wired either through the D-sub connector or the 7W2 connector.

When the SmartMotor is a terminating node on the CAN bus, the 120 Ohm terminating resistor (shunt) must
be wired to pins 13 and 14 of the 26-pin D-sub connector, or use CBLHD26-ASM with internal jumper CAN
TERM ON. A 120 Ohm terminating resistor (shunt) is also required at the beginning of the CAN bus. See
the next figures.

For further convenience, a 26-pin pass-through D-sub connector (Pass-Thru Terminator, PN: CBLSM-
TR120) is available that contains a built-in 120 Ohm terminating resistor (shunt). When a SmartMotor is the
terminating node and the 7W2 wiring method is used (described previously), you can simply install the
pass-through connector on the SmartMotor's 26-pin D-sub connector to serve as the terminator.
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CDS on the 7W2 Connector (CDS7)

— 1 —
N
Power/Servo SMART 2 Motor as
LED P~ £ inati )
O ' it oL — 2 Terminating Node 26-Pin D-sub
: ; 120 Ohm Terminator
Trajectory . ® @ o i Connector
LED (Bt) ™ g . wa—‘ PIN | DESCRIPTION
\o 5|16 17 | CANHigh
7W2 D-sub Conn. ® |18 [CANLow |
f — | other pins are as previously
Pin Numbers E % shown. See the D-Style Con-
PIN ‘DESCR”)T'ON / :D/ nector Pinouts table later in
1 CAN Low this guide for full details.
2 | CANHigh . 00
All other pins are as previously \0 @ 0
shown. See the D-Style Con- ‘) Q
nector Pinouts table later in
this guide for full details.
Incoming CAN on
7W2 connector
CAN Low T P oo \ ] ] \

h Hith] ( WI

120 Ohm Terminator l | ||
at Bus Controller
(PLC, Host, HMI)
N OT W0 N Ot W0
D 7W2 D-sub Female D DI 7W2 D-sub Female U

1 CAN Low
2 CAN High
N ™0 5 Shield Drain

7W2 D-sub Female

OR CAN L_ow —f When motor is an end
CAN High 120 Ohm :n:de or;hCAzr\é b'ﬁ's’DinSti"
; is on the 26-pin D-sub:
Incoming CAN on Terminator g

26-pin connector ' I ' :v-—l jrg?mci)nhaTor
(NO incoming CAN 18
OR use int. jumper CAN

leads on the 7W2)
OR use int. jumper - ~e g TERM on CBLHD26-ASM

CAN TERM on
CBLHD26-ASM U] 26-pin D-sub Male (U

NOTE: A terminating resistor (shunt) or internal jumper on CBLHD26-ASM is required at each end
of the bus. Bus must be multi-drop as shown, not a star network. 24V CAN bus power connection is
not required at the motor.

Schematic for CDS7 Option, D-Style SmartMotor Used as Terminating Node

For the above methods, the incoming CAN bus signal is connected to the 7W2 connector OR the 26-pin
connector, and the CDS Add-A-Motor cable (PN: CBLSMCDS-xM) will automatically provide CAN bus,
RS-232 and power wiring in one cable between motors.

The next figure shows how factory cables are used to attach the incoming power and RS-232
communications to the 7W2 connector, and incoming CAN bus signal to the 7W2 connector OR the 26-pin
connector (each method requires different cables).
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Industrial Ethernet Network

CBLPWRCOM3-xM

/

Incoming Power

Incoming RS-232 > -

120 Ohm
Terminator

Incoming CAN on
7W2 Connector

OR

Incoming RS-232) lﬁl

Incoming Power =
=5 ENs

CBLHD26-ASM

Incoming CAN on
26-Pin D-sub

CBLSM1-xM
CBLSMCDS-xM

Note BLUE connectors
that differentiate the
CDS?7 cables from

standard Add-A-Motor
cables.

——>» @

If motor is end node, put
int. jumper CAN TERM
ON (under cover)
to activate 120 ohm
terminator

When motor is an end
node on CAN bus, install
this on the 26-pin D-sub:

17 120 Ohm
18 —/—vw—l Terminator
OR

Use CBLHD26-ASM with
int. jumper CAN TERM ON

There must be NO
incoming CAN wires
on the 7W2 connector.

Connector shell is from Moog Animatics;
cable is customer supplied

NOTE: A terminating resistor (shunt) or internal jumper on CBLHD26-ASM is required at each end
of the bus. Bus must be multi-drop as shown, not a star network. 24V CAN bus power connection is
not required at the motor.

CDS7 Option Cabling Diagram

Refer to these tables for part numbers and cable lengths:

CDS7 Length Power/Com Length

Cable PN (Meters) Cable PN (Meters)
CBLSMCDS-0.3M 0.3 CBLPWRCOM3-xM* 5,10
CBLSMCDS-0.9M 0.9 CBLSM1-xM** 3,10
CBLSMCDS-3.0M 3.0 CBLHD26-ASM**
CAUTION: As noted by the BLUE con- *Recommended method
nectors, these are NOT the same as the **QOptional method
Add-A-Motor cables shown on page 37, and
they are NOT interchangeable.

See the cable data on the website or consult the factory for the schematic diagrams.

For PN: CBLHD26-ASM, see Class 6 D-Style HD26 Cable Connector (PN: CBLHD26-ASM).

Industrial Ethernet Network

NOTE: If you have set your PC's network adapter to a fixed IP address for temporary connections to
SmartMotors with SMI, remember to return it to DHCP when done to avoid local area network
connectivity issues.
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Min and Max Cable Length

The Industrial Ethernet network is used for the EtherCAT (-EEC), EtherNet/IP (-EIP) and PROFINET
(-EPN) options. Most Industrial Ethernet (IE) networks support line, tree or star device-connection topology.
Tree or star network may require switches/hubs designed for that network type. Requirements for specific
configurations depend on the capabilities of the controller device, the follower devices, and use of other
networking equipment. For more details, refer to the corresponding SmartMotor fieldbus manual.

CAUTION: To minimize the possibility of electromagnetic interference (EMI), all
connections should use shielded Ethernet Category 5 (Cat 5), or better, cables. All
interconnecting cables in the daisy chain and/or ring configuration for Industrial
Ethernet must have a length of at least 1 meter (3.28 feet).

The next diagram shows an example Industrial Ethernet network with the SmartMotors daisy chained to the
controller device. A "ring" configuration can be created if the controller device has two ports.

CAUTION: When daisy-chaining SmartMotors for an EtherCAT network, you must
connect the OUT port of the upstream motor to the IN port of the downstream motor.
Refer to the Ethernet ports labeling on your SmartMotor.

Industrial Ethernet Network

PATENTS 5912641 PATENT# 5912641

- 1/0 block,
- Servo drive,
- etc.

Other follower device:

Controller device:
- PC,

-PLC,

- etc.

L

Optional ring for cable redundancy**

*IN/OUT applies only to EtherCAT networks. Refer to the previous CAUTION and motor labeling.

**Ring configuration requires a controller device with two ports

Min and Max Cable Length

The minimum shielded Ethernet Cat 5 cable length between network nodes must be 1 meter.

For transmission speeds of 100 Megabits/second on shielded Ethernet Cat 5 cable, most Industrial
Ethernet networks allow a maximum cable length up to 100 meters between network nodes.
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Ethernet Cables

Ethernet Cables

For the Class 6 D-style SmartMotor with the Industrial Ethernet option, no special cables are required. That
option adds a dual-port switch with 2 standard RJ45 connectors on the back of the motor. Those allow
connection to your network, and also daisy chaining between motors using standard (not-crossover), off-
the-shelf Cat 5 or better Ethernet cables, which are available from consumer electronics and computer

supply stores.

NOTE: A crossover cable is not required. The Industrial Ethernet ports include an "auto-crossover"
feature that will engage as needed.
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Understanding the Status LEDs

Understanding the Status LEDs

The section describes the functionality of the status LEDs on the Class 6 D-style SmartMotors.

LED 0: Power/Servo LED
Off No power

Solid green Drive on

Blinking green  Drive off, no faults

Triplered flash ~ Watchdog fault

Solid red Faulted or no drive enable input
Alt.red/green  Inboot load; needs firmware

LED 0 and 1 Status on Power-up:
» With no program and the travel limit inputs are low:
LED O solid red; motor in fault state due to travel limit fault

LED 1 off
» With no program and the travel limits are high:
LED O solid red for 500 milliseconds then flashing green
LED 1 off
» With a program that only disables travel limits:
LED O red for 500 milliseconds then flashing green
LED 1 off

. Industrial Ethernet Option
LED 2: (Network specific) LED

Refer to the corresponding SmartMotor
fieldbus guide
LED 4 &6 Link LEDs
Off No/bad cable; no/bad Link port
Solid green Link established

LED 1 Trajectory LED
LED 0 Power/Servo LED

LED 4 &6 Link LEDs
LED 5 & 7 Activity LEDs

LED 2 (Network specific) LED
LED 3 (Network specific) LED

Industrial Ethernet Option

LED 1:Trajectory LED R
Off Not busy
Solid green Drive on, trajectory in progress

Flashing#red Flashes fault code (see below)
when Power/Servo LED is solid red

Fault Codes: pauses for 2 sec before flashing the code
Flash Description

NOT Used

Bus Voltage

Over Current

Excessive Temperature

Excessive Position

Velocity Limit

dE/Dt - First derivative of position error is excessive
Hardware Positive Limit Reached

Hardware Negative Limit Reached

Software Positive Travel Limit Reached
Software Negative Travel Limit Reached

[y
CoLwONO U~ WN

. Industrial Ethernet Option
LED 3: (Network specific) LED

Refer to the corresponding SmartMotor
fieldbus guide

LED 5 & 7 Activity LEDs
Off No activity

Blinking amber  Activity

Detecting and Communicating with the SmartMotors

NOTE: Depending on the SMI software version and SmartMotor model being used, the software
version and motor information may be different on your screens.

This section describes how to detect and address the Class 6 SmartMotor.
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Understanding the Detection and Configuration Options

This procedure assumes that:
» The SmartMotor is connected to the computer.
« The SmartMotor is connected to a power source.

« The SMI software has been installed and is running on the computer. For details, see Installing the
SMI Software on page 26.

Understanding the Detection and Configuration Options
NOTE: This feature requires connection to the serial (COM) port, configured as RS-232 or RS-485.

There are several ways to use the SMI software to find and address the Class 6 D-style SmartMotors that
are connected to your PC:

» Use the Find Motors button—this method is recommended for first-time communications or when you
don't know the port used to connect the motors. For details, see Using the Find Motors Button on
page 47.

« Use the Detect Motors feature—this method can be used if you know the communications port used
to connect your motors and if your motors may be pre-addressed. For details, see Using the Detect
Motors Feature on page 50.

Several of these methods are described in the next sections.

Using the Find Motors Button

The easiest way to locate any connected SmartMotor is to use the Find Motors button (see the next figure).
This method searches all ports on the PC for connected motors.

To begin searching for motors on the PC, in the Configuration window of the SMI software interface, click
Find Motors. The SMI software begins searching for all SmartMotors connected to the PC.

NOTE: The next figures show examples for an RS-232 SmartMotor. To see similar example figures for
USB motors, refer to Using the Detect Motors Feature on page 50.
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Using the Find Motors Button

[ Fle  Edit View  Communication Compale Toolk Window Helg
REdHd R EE b AR SR »m OR\ EH W

I Fird Meosas Coml | Etheinel | USE | CAM Chanrel D |

™ Open |r-\l Mihors ;lEH‘Bn:I Paoil

I

1= b Detected Configuation
3 Coml [RS2-5600 b

Ethana
ush
CAN Channel 01 25000 bps)

Delectig SemadlepsSmaiiMolor on ASZ3E bus "Coml” Flaase wal

Loakang lor motol addigss 1

_Cared_|

| L..| Desciption
i Dielecirg Sersat lepe/SmaniMolors on R5-822 bis: "Caml"

Far Help, press FL
—_—

Find Motors Detecting SmartMotors on the RS-232 Chain

After the process has completed, the SMI software shows the found motors in the Configuration window
under the corresponding communications port. Each motor is represented by a motor icon; the motor's

address and firmware version are shown next to the motor icon.

Find Motors |

- Detected Configuration
Elféy" Com1 [RS5232-9600 bps)
(@ Mator!-Com1 [5.4.254)

----- Ethernet
% USE

Configuration Window Showing Found/Detected RS-232 SmartMotor

To address the motor, right-click on the motor and select Set Motor Address. For more details, see the
SMI Software Help, which can be accessed within SMI by pressing F1 or from the Help menu.
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Using the Find Motors Button

Find katars |

El--@ Il[)ete-::ted Configuration
Elr;g" Corml [R5232-3600 bps)

Motor View
b Ethermet
se Motor Properties
| Set Motor Address

- R ma [

Motor Menu - Set Motor Address

The motor's detailed information can be viewed in the Motor View window, which is accessed by selecting
the Tools > Motor View > Info tab.

B Motor View - "Motorl-Com1" *

Statuz | Info Mu:unitu:ur] Idzer "v"arial:-les] Flagz ] Ealculatiuns] Trace ] Netwu:urk]

Mator Mame: |I'-1|:|t|:|r'| -Cam
Motor Address: |1
Wersion: |6.4.2.54
Serial Mumber; |P247352
bdodel: |5M231EE‘-DT-EEE

Sample Period: |0.062500 ma
Proararn Mame: |<END>
Davenload Time: |EIS.-’1 2022 151847 [rndAy b )
Program Size: |EE| Bytes

Ship Date: |02/22/2022
Fimware Date: [Mar 2 2022 17.12.08

Scaling:

Mo zcale iz defined faor thiz motor. To define scale, click the "Edit
Froperties'" button.

ADB Dizplay Save ADB

Details Edit Properties Get Info

Motor View Information Tab
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Using the Detect Motors Feature

Using the Detect Motors Feature

This method is similar to the Find Motors method, but it searches only the specified communications port
for connected SmartMotors. This is also the recommended method for detecting Class 6 D-style motors
after they have been pre-addressed and daisy-chained to the communications port.

To use the Detect Motors feature, in the Configuration window of the SMI software, right-click the desired
communications port and select Detect Motors from the menu.

@ SrartMotor Interface

File Edit View Communication Ceompile Toels Window

D& L) o/
Configuration ______________________Ji[Termin
EDmS]
[ Open

Find botors |

El--m Detected Configuration

% Etherre Port Properties
5B Detect (and Address) Motors on R5-232

Set Baud Rate
Address R5-232 Chain

Download Firmware

Selecting the Detect Motors Feature

The SMI software begins searching for all SmartMotors connected to the specified communications port. A
progress bar is shown while the SMI software searches for the motors.

After the process has completed, the SMI software shows the found motors in the Configuration window
under the corresponding communications port. Each motor is represented by a motor icon; the motor's
address and firmware version are shown next to the motor icon.

Find Matars |

E- Detected Conliguration
Eg Cornl [R5232-9600 bpz)
(B Motor!-Coml [5.4.2.54)

----- Ethernet
-2 USE

Configuration Window Showing Found/Detected SmartMotor

To address the motor, right-click on the motor and select Set Motor Address. For more details, see the
SMI Software Help, which can be accessed within SMI by pressing F1 or from the Help menu.
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Using the Detect Motors Feature

Find kators |

El--@ Detected Configuration
Elr;g" Com1 [R5232-3600 bps)

_____ % Ethermst Motor View
LSE Motor Properties
Set Motor Address

- aEd i [

Motor Menu - Set Motor Address

The motor's detailed information can be viewed in the Motor View window, which is accessed by selecting
the Tools > Motor View > Info tab.

B Motor View - "Motor1-Com1" )4

Statuz | Info Mnnitnr] dzer Variables] Flags ] Ealculatiuns] Trace ] Netwu:urk]

Mator Mame: |M|:|t|:|r'| -Caom
Motor Address: |1
ergion: |E.4.2.54
Serial Number: |P247352
odel: |5M231EEDT-EEE

Sample Perind: |0.062500 s
Prograrn Mame: |<END>
Davanload Tirme: |EIS.-"1 FA2022 15:18:47 [rndw b )
Program Size: |EE| Bytes

Ship Date: |02/22/2022
Firmware Date: Mar 2 2022 17:12.08

Scaling:
Mo zcale iz defined faor thiz motor. To define scale, click the "Edit
Froperties' button,

ADE Dizplay Save ADB

Detailz Edit Fropertiesz et Info

Motor View Information
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Checking and Clearing the Status Bits

Checking and Clearing the Status Bits

NOTE: In addition to the software information in this section, there is context-sensitive help available
within the SMI software interface, which is accessed by pressing the F1 key or selecting Help from the
SMI software main menu.

The Motor View window is used to view and monitor various motor parameters. It is used in conjunction
with the Terminal window to clear any active overtravel limits.

This procedure assumes that:
» The SmartMotor is connected to the computer.
o The SmartMotor is connected to a power source.

« The SMI software has been installed and is running on the computer. For details, see Installing the
SMI Software on page 26.

e The SmartMotor has been detected and addressed.
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Polling the Motor

Polling the Motor
To view the current state of the status bits, you must poll the motor.
1. Double-click the motor icon to open the Motor View window (see the next figure).

2. Click the Poll button to begin polling data from the motor.

B Motor View - "Motor!-Com1" *

llnfu:u ] Mu:unitu:ur] Idzer "v"arial:-les] Flagz ] Ealculatiuns] Trace ] Netwu:urk]

1 s | T oniine
r [ Hex Display Diagnostics 1

Position:|0 |Status Wiard 0 j
Pas. Errar:|0
Welocity: 0 0 (3 Drive ready

Mode:[Pasition (1] 1 i Bo: Motor is off
23 Bt: Trajectory in progress
|N|:|ne :Iv 3 (3 Bus voltage fault
|N|:-ne "l 4 (3 Ba: Owvercurrent occurred

5 (3 Bh: Excessive temperature fault

Input/Uutput: Red 2dv. Grey Ov E % Be: Excessive position error

01 23 4567 7 @ Bv: Velocity limit
@200 0000 g ':l' Realtime temperature limit

g g 9 (3 de/dt error limit

o 10 @ Positive HW limit enabled

11 @ Negative HW limit enabled

12 @ Br: Historical positive HW limit
13 @ BL Historical negative HIW limit
14 @ Bp: Positive HW limit asserted
15 @ Bm: Negative H/W limit asserted

Clear Flags [Z5) |

Ver: 6.4.2.54 Model: SM23166D-ETH

Motor View

A SmartMotor with no program and no I/O connections will boot up with active overtravel limits (see the red
status bits numbered 10 through 15 in the previous figure).
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Clearing the Overtravel Limits and Fault Bits

Clearing the Overtravel Limits and Fault Bits

To disable (clear) the overtravel limits, enter EIGN(2) and EIGN(3) in the SMI software Terminal
window. This sets I/O 2 (positive overtravel limit) and I/O 3 (negative overtravel limit) as general
inputs/outputs instead of being used as travel limits. To set all status bits in Word 0 as general

inputs/outputs, enter EIGN(W,0).

NOTE: You can either type the command in the white text box or type the command directly in the blue

area of the terminal screen and then click Send or press Enter.

The active and asserted bits are cleared, as shown in the next figures.

Terminal

Coml |Ethemet | USE | CAN Charnel 0 |
[v Open |.fl‘-.llh-1|:|t|:|rs j|I:-:|m1,EEDD,HSESE,Eh:D,Em

| Send

EIGH (W, 0)

EIGN Command Entered

10 3 Positive HAW limit enabled

11 0 Negative HAW limit enabled

12 @ Br: Historical positive HW limit
13 @ BE Historical negative HIW limit
14 3 Bp: Positive HW limit asserted

15 (3 Bm: Megative HOW limit asserted

Active and Asserted Bits Cleared

To clear the historical fault bits, enter ZS. All remaining fault bits are cleared, as shown in the next figures.

Terminal

Coml | Ethemet | USE | CAN Chanrel 0] |
[v Open |ﬁIIMn:utn:|rs j|E|:|m1,EEEIELF!SESZ,Eh:ELEm

| Send |

EIGHN (W, 0)

ZS Command Entered

10 O3 Positive HAW limit enabled

11 3 Negative HAW limit enabled

12 3 Br: Historical positive HAW limit

13 3 Bl Historical negative HAW fimit

14 3 Bp: Positive HAW limit azzerted

15 (3 Bm: Negative HAW limit asserted

Remaining Bits Cleared
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Moving the SmartMotor

Moving the SmartMotor

NOTE: In addition to the software information in this section, there is context-sensitive help available
within the SMI software interface, which is accessed by pressing the F1 key or selecting Help from the
SMI software main menu.

The SMI software contains a Torque mode that is used to test the motor response and ensure the drive is
operating properly.

This procedure assumes that:
» The SmartMotor is connected to the computer.
o The SmartMotor is connected to a power source.

« The SMI software has been installed and is running on the computer. For details, see Installing the
SMI Software on page 26.

e The SmartMotor has been detected and addressed.

» The fault bits have been cleared. For details, see Checking and Clearing the Status Bits on page 52.

Making the Motor Move

WARNING: The larger SmartMotors can shake, move quickly and exert great force.
Therefore, proper motor restraints must be used, and safety precautions must be

considered in the workcell design (see Other Safety Considerations on page 9).

To make the SmartMotor move:

1. Inthe Terminal window, select the tab that matches the communications channel to which your
motors are connected. To do this, look at the Configuration window, find the channel where the
motors are listed and click that tab name in the Terminal window.

Terminal

Find Motors Ethemnet L
E|" 1 nnfin abior 'F I:II:'EH .":"-" MDtDI
[R5232-3600 bps] |

Tab Selected that Matches the Communications Channel

NOTE: If you do not have the correct tab selected, the commands you enter will not go to the
motors and there will be no response.
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Setting and Reporting Torque

2. Enter these commands in the Terminal window:
Coml | Ethemet | USE | CAN Channel 0]
v Open |ﬁi‘«IIMn:uh:|rs j|I:-:|m'|,HEDD,HSEEE,Eh:D,Em

| Send

You should immediately see the motor shaft moving in the positive direction (clockwise, when
looking at the end of the motor shaft). If the motor does not respond to the commands, see
Troubleshooting on page 70 for troubleshooting tips.

NOTE: Macros (shortcut keys) can be used to simplify entry of frequently-used commands. For
details, see Macros in the SmartMotor™ Developer's Guide.

3. After you have observed the motor shaft turning, enter the X command to decelerate the motor to a
stop.

Setting and Reporting Torque

The commands in this section are related to the previous motion procedure. For more details on these
commands, see the SmartMotor™ Developer's Guide.

MT (Mode Torque)

MT sets the mode of operation to torque mode. In this mode, the SmartMotor shaft applies a torque
independent of position. For more details, see Torque Mode in the SmartMotor™ Developer's Guide.

T=formula (Set Target Torque)

T can be set to any value from -32767 to +32767, which represents -99.99% to +99.99% PWM (pulse-width
modulation) commanded.

RTRQ (Report Actual Torque)
Enter RTRQ at the Terminal window to report the commanded torque from the trajectory generator.

Note that RTRQ typically reports a value that's one less than the T value. In the previous example, T=3000,
but RTRQ reports 2999. The value returned by TRQ (and RTRQ) will typically be one less than the T
(torque) value due to internal calculations. It may also be reduced in cases where the motor’s output is in
limitation. TRQ represents the output effort of the motor in both MT (torque mode) and servo modes (MV,
MP, etc.). Therefore, it provides a seamless transfer across those modes without causing a ripple or bump
in force to the load.

TS (Set Torque Slope)

The TS command defines how fast the processor applies a change in torque. For an example of the
TS command, see the Chart View Example in the SmartMotor™ Developer's Guide.

Torque slope can range from -1 to 2147483647 (default). At a value of 65536, the processor changes
torque by a value of 1 for each PID sample. The default sample rate is 16000; you can view the current
sample rate with the RSAMP command.
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Checking the Motor Position

NOTE: If you're moving from a Class 5 to a Class 6 SmartMotor, the faster Class 6 sample rate means
the torque slope operates twice as fast in real-world time.
Checking the Motor Position
There are several ways to check the motor position:
» Report the position using commands from the Terminal window
» View the position in the Motor View tool

These two methods are described in the next sections. You can also view the position in the Monitor or
Chart View software tools. For details, see SMI Software Features in the SmartMotor™ Developer's Guide.

This procedure assumes that:
« The SmartMotor is connected to the computer.
» The SmartMotor is connected to a power source.

» The SMI software has been installed and is running on the computer. For details, see Installing the
SMI Software on page 26.

« The SmartMotor has been detected and addressed.

« The fault bits have been cleared. For details, see Checking and Clearing the Status Bits on page 52.

Viewing the Motor Position with a Report Command

To report the motor position, in the Terminal window, issue the RPA (Report Position Actual) command:
RPA

The terminal responds with the current position of the motor:

RPA 3593657

NOTE: The position is reported on the same line as the command; there is no line feed or carriage
return for "report" commands.

The RPA command reports the actual motor position at the time the command was issued. Therefore, it is
just a "snapshot"—if the motor is moving, the reported position is not dynamically updated.
Viewing the Motor Position with the Motor View Tool

The Motor View tool provides another way to view the motor position. The advantage of using this tool is
that the position is dynamically updated when the motor is moving.
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Viewing the Motor Position with the Motor View Tool

To open the Motor View tool, from the SMI software Configuration window, right-click the motor you want to
view and select Motor View from the menu.

Find Matars |

B- E Detected Configuration
El r;yf Coml [R5232-3600 bps)

I Motor View I

Ethernet

USE Motor Properties
LAN Cha Set Motor Address

Opening the Motor View Tool

After the Motor View window opens, click the Poll button to begin polling (getting information from) the
motor. After polling begins, the motor position is shown in the Position box.

B Motor View - "Motorl-Com1" *

4 1rfo ] Munitor] Uszer Variables] Flags ] Ealculations] Trace ] Netwu:urk]

R -
[T Sealed [ Hex Display Diagnostics 1

Position: SDDDD |Status - j
Posz. Emor:
Yelociy: 0 0 @ Drive ready

Wode: Pasition [1] 13 Bo: I.'Il:lltur e |:|f.f
23 Bt Trajectory in progress

None :Iv 3 {3 Bus voltage fault
Mone - 4 (J Ba: Overcurrent occurred

52 Bh: Exceszive temperature fault

Input:’Dutput' Red 24v. Grey v £ 3 Be: Excessive position error

2 3 45 6 7 7 3 Bv: Velocity limit
D 'D QOO0 80 Reaktime temperature limit
g g 9 3 defdt error limit
OO 10 3 Positive HAW limit enabled

11 3 Megative HAY limit enabled

12 3 Br: Historical positive HAW limit

13 ¢33 Bl Historical negative HAW limit

14 33 Bp: Positive HAW limit asserted

15 (3 Bm: Megative HAW limit asserted

Clear Flags [25) |

Ver: 6.4.2.54 Model: SM23166D-ETH

Motor View Tool Showing the Motor Position
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Connectors, Pinouts and Examples

Connectors, Pinouts and Examples

This chapter provides information on the SmartMotor connector pinouts and specifications. It also provides
example I/0O connection diagrams. For information on connecting the motors, see .

Class 6 D-Style Connector Pinouts ... 60
Class 6 D-Style I/0 Connection Examples ... ] 61
Class 6 D-Style HD26 Cable Connector (PN: CBLHD26-ASM) ............................................... 63
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Class 6 D-Style Connector Pinouts

Class 6 D-Style Connector Pinouts

This table shows the pinouts for the connectors on the Class 6 D-style SmartMotors.

>>UuHAWNBRE

OoO~NO U WN K

=
= o

12
13
14
15
16
17
18
19
20
21
22
23
24
25
26

CAN Low (also onHD26)

CAN High (also on HD26)

RS-232 Transmit (COM CH 0)

RS-232 Receive (COM CH 0)

SIG Ground

Main Power

Common Ground (req'd. POWER Ground)

INO GP, also Analog Input

IN1 GP, also Analog Input

IN2 Positive Limit or GP

IN3 Negative Limit or GP

IN/OUT4 GP or Ext. Enc. Index Capture
IN/OUT5 GP or Int. Enc. Index Capture
IN6 GP, G Command or Homing Input
IN7 Drive Enable Input (Dedicated)
IN/OUT8 GP or Brake Line Output
IN/OUT9 GP or Not Fault Output

+24 VDC Control Power

Control Power Return (Ground, Common)
Encoder A+Input
Encoder A- Input
Encoder B+Input
Encoder B- Input

CAN High (also on 7W2)
CAN Low (alsoon 7W2)
RS-485B (COM CH1)
RS-485 A (COM CH1)
nc.

nc.

USB +5V Bus

USB D+

USBD-

Ground, Common

1 Mbit/sec Max

115.2 KBaud Max

+24-48 VDC

4V logicl/O,
range 18- 32 V max
Ground Reference

1.5 MHz max as Enc or
Step input

1 Mbit/sec Max

115.2 KBaud Max

Redundant to HD26
connector M2 Comio
D-Sub Connector
3 (112) P
Cl @00 ® L)
SeeNOTE

Must be Main Power Ground

For Inputs: 9 Conf gurable
and 1 Dedicated

Low LvI Thid: 3.6 V Max
HighLvl Thid:6.0 V Min
Analog Input Scale: 10V FS
Inp Impedance >10 Kohm

. HD26-Pin D-Sub 1/O
For Outputs: Do not exceed Toprow: 9 8 76 543 21

200 mAmps source eachor | Mid row: 18 17 16 15 4 13 12 1110

400 mAmps combined = '-‘—- P—
Also supplies I/0; P T
do not exceed 32 V max 00000000
Nonisolated Btmrow: 2252423221201
Redundant to 7W2

connector

For programming fromSMI,

not recommended for

running the motor

NOTE:These motors canoperateonpowerdownto +20VDC, but it is not recommended dueto greatly reduced
performance —optimumperformanceis achievedat 48 VDC.

NOTE:Optional dual-port Ethernet connectors (not shownabove) areindustry standard R]45 and compatible with
off-the-shelf Cat 5 or better cables availableat any consumer electronics or computer supply store.

NOTE:All specif cations are subject to change without notice. Consult the factory for the latest information.

P226-Pin
D-Subl/O

L

P1 7-Pin Combo
D-Sub Power

&I/0

Trajectory | —ouT* _IN*

= |

PWR/Servo
LED

Optional Dual-Port Industrial Ethemet
*N/OUT applies only to EtherCAT networks

CAUTION: DO NOT exceed the specif ed voltage limits,
as this may cause immediate damage to the internal
electronics, which will void the warranty.

CAUTION: Pins 11 and 12 are intended as an input for
control/ 10 power only. DO NOT attempt to use those
pins for main servo-drive power, as this may result in
immediate damage to the electronics, which will void
the warranty.
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Class 6 D-Style I/O Connection Examples

Class 6 D-Style 1/0 Connection Examples

This section shows I/O connection examples for the Class 6 D-style motors. Also, refer to Class 6 D-Style

Connector Pinouts on page 60 for connector specifications.

Switches and umKh NOTE: |/O is Sourcing type (PNP)
- — - @ IN-1 PIN | DESCRIPTION PIN | DESCRIPTION
Pos/ Right Limit (Dry Switch) 3) IN2 1 | INOGP, also Analog Input 14 | Encoder A- input
Neg/ Left Limit (Dry Switch) 2 | IN1GP, also Analog Input 15 | Encoder B+input
{4) IN-3 3 | IN2 Positive Limit or GP 16 | Encoder B- input
Momentary Switch IN-4 4 | IN3 Negative Limit or GP 17 | CANHigh (also on 7W2)
5 IN/OUT4 GP or BExt. Enc. Index Capture 18 | CANLow (alsoon 7W2)
6 IN/OUTS5 GP or Int. Enc. Index Capture 19 | RS-485B(COMCH1)
7 IN6, G cmd or Homing Input 20 | RS485A (COMCH1)
| 8 | IN7, Drive Enable Input (Dedicated) 21 | nc
PNP 9 | IN/JOUTS, GP or Brake Line Output 22 | nc
Sense 10 | IN/OUTO, GP or Not Fault Output 23 | USB45VBus
11 | +24VDCControl Power 24 | USBD+
24\DC 12 | Control Power Rin (Ground, Common) 25 | USBD-
User Supplied 13 | Encoder A+Input 26 | Ground, Common
HD26-Pin D-Sub 1/0
Toprow: 9 8 76 543 21
Mid row: 18 7716154 1312 11 10
000000000
000000000
0000000
Btmrow: 2252422212019
Cass 6 D-Style Analog Pot and Sensor NOTE: /0 is Sourcing type (PNP)
P + nput 7y | PIN_| DESCRIPTION PIN_[ DESCRIPTION
Input @ 1 | INOGP, also Analog Input 14 | Encoder A- input
2 | IN1GP,also Analog Input 15 | Encoder B+input
@ 3 | IN2 Positive Limit or GP 16 | Encoder B- input
Analog 4 | IN3 Negative Limit or GP 17 | CANHigh (also on 7W2)
Bontometer (@ [ 5 | INJOUT4GPorBxt. Enc.IndexCapture| | 18 | CAN Low (also on 7W2)
® Input Q 6 | INJOUT5 GP orInt. Enc. Index Capture 19 | RS485B(COMCH1)
Inout 7 | IN6, Gemd or Homing Input 20 | RS-485A(COMCH1)
0—4’¢@ 8 | IN7, Drive Enable Input (Dedicated) 21 | nc
Analog Output @ 9 | IN/OUTS, GP or Brake Line Output 22 | nc
Sensor 10 | IN/OUT9, GP or Not Fault Output 23 | USB+45VBus
11 | +24VDCControl Power 24 | USBD+
Output 12 | Control Power Rtn (Ground, Common) 25 | USBD-
@ 13 | Encoder A+Input 26 | Ground,Common
o 24VDC
~ User supplied
12 Ground
1/0 TYPE

The Class 6 D-style motor I/O is Sourcing type (PNP).

DRIVE ENABLE

The Drive Enable input (pin 8) must be satisfied in order for the motor to turn.
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Class 6 D-Style I/O Connection Examples

24 VOLTS DC POWER
Pin 11 is not a source for 24 VDC power; it is an input only.

 1/O devices must be sourced from an external power supply.

« Loads on specific outputs are allowed (when within the described limits).
ANALOG INPUTS

« Analog input reading will be saturated at 10 VDC, although the control power level can go up to 24
VDC. In other words, if you place an analog voltage into it, and it went from 0 to 24 VDC, the reading
will max out at 10 VDC, even though the input voltage keeps rising.

DIFFERENTIAL ENCODER
The Differential Encoder inputs use the standard RS-485 chipset:

« If atrue differential output TTL encoder is used, just wire A and B signals as labeled.

ﬁ CAUTION: NO differential encoder signals higher than 5V TTL should be used!

RS-485

~ /\//\//_\ M\ /\_//'\\_//\_//ﬂ

“, n

Device “n
(end)

Note: The 620 ohm biasing resistors are not needed in most cases but recommended if there are
communication problems.
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Class 6 D-Style HD26 Cable Connector (PN: CBLHD26-ASM)

Class 6 D-Style HD26 Cable Connector (PN: CBLHD26-ASM)

Part CBLHD26-ASM is available so that users can construct their own interface cable for the Class 6 D-

style SmartMotor. The connector (with customer-supplied cable) attaches to the HD26 D-sub connector on
the motor. The figure and table show the PCB connection points for the cable.

OCoO~NOUB WNPKF

=
= o

12
13
14
15
16
17
18
19
20
21
22
23
24
25
26

PN:CBLHD26-ASM

19000 eeee
QQ00000OC
QQ00000O0C©

17
108
109
24v

RTN
A+
A-
B+
B-
cP
C N

RS485B

RS485A

RTN
SH
CAN TERM

26

18

26

INO GP, also Analog Input

IN1 GP, also Analog Input

IN2 Positive Limit or GP

IN3 Negative Limit or GP

IN/OUT4 GP or Ext. Enc. Index Capture
IN/OUTS5 GP or Int. Enc. Index Capture
IN6 GP, G Command or Homing Input
IN7 Drive Enable Input (Dedicated)
IN/OUT8 GP or Brake Line Output
IN/OUT9 GP or Not Fault Output

+24 VDC Control Power

Control Power Return (Ground, Common)
Encoder A+Input

Encoder A- Input

Encoder B+Input

Encoder B- Input

CAN High (also on 7W2)

CAN Low (alsoon 7W2)

RS-485B (COM CH 1)

RS-485 A (COM CH1)

USB +5V Bus
USB D+

USB D-

Ground, Common
Ground, Common
Shield

Cover removed to show internal PCB

4V logicl/O;
range 18 - 32 V Max
Ground Reference

1.5 MHz max as Enc or
Step input

1 Mbit/sec Max

115.2 KBaud Max

Jumper - CAN 120 OhmTermif start/end CAN node

For Inputs: 9 Conf gurable
and 1 Dedicated

Low LvI Thid: 3.6 V Max
HighLvi Thid:6.0 V Min
Analog Input Scale: 10V FS
Inp Impedance >10 Kohm

For Outputs: Do not exceed
200 mAmps source each or
400 mAmps combined
Also supplies I/0;

do not exceed 32 V max
Nonisolated

Redundant to 7W2
connector

Forthe USB connectoron
PCB; used to programfrom
SMI, not recommended for
running the motor

Additional ground points

ON =terminated

NOTE: All wiring should be twisted pairs unless otherwise noted. Cable should be shielded with spiral wrap alumi-
nized tape and a.5 mn¥ drain wire of stranded tinned copper. Consult the factory for the more information.

CAUTION: DO NOT exceed the specif ed voltage limits, as this may cause immediate damage to the internal
electronics, which will void the warranty.

CAUTION: Pins 11 and 12 are intended as aninput for control/10 power only. DO NOT attempt to use those pins for
main servo-drive power, as this may result inimmediate damage to the electronics, which will void the warranty.

NOTE: All specif cations are subject to change without notice. Consult the factory for the latest information.
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Other Class 6 D-Style Changes

Other Class 6 D-Style Changes

This chapter provides information on getting started with your SmartMotor.

Batteryless Absolute Multiturn Encoder ... 65

Absolute Encoder Control COmMmMaNndS ......... ...t 65
EOBK(IO) Command Limitations ... .. . 65
EOFT(IO) Command Limitations ... 65
Ethernet Error, Status Word 2 Bit6 ... . 65
/O Control Details ................... 66

/O Control EXamples ... . 67
Scale Factor Calculation-Sample Rates ... ... . . 67
Commands for Class 6 ... 68
Commands That Have Changed ... ... . 69
Commands Not Supported ... . 69
Commands Supporting the DS2020 Combitronic System ... ... 69
Features not Available in Class 6 D-Style ... ... ... . . 69
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Batteryless Absolute Multiturn Encoder

Batteryless Absolute Multiturn Encoder

The batteryless absolute multiturn encoder is a standard feature on every Class 6 D-style SmartMotor. It is
a magnetic absolute multiturn encoder that requires NO backup battery. Its internal circuitry allows the
motor to retain the absolute encoder position and allows continued multiturn position tracking when main
power is removed from the motor. This provides the benefits of no rehoming and minimized downtime when
main power is removed due to an emergency stop, power outage or other cause.

Absolute Encoder Control Commands

This section describes the batteryless absolute multiturn encoder control commands that are available for
the Class 6 D-style SmartMotor. For more details on these commands, see the SmartMotor™ Developer's
Guide.

CAUTION: Use of the O= or OSH= command will confuse the absolute position information.
Therefore, do not use these commands. Instead, use the ENCCTL command (described in this
section).

ENCCTL(-1,x) removes the effect of the ENCCTL(0,x) command — the PA offset is then set as shipped
from factory.

X can be any value.

ENCCTL(0,x) sets the absolute position to x, offset is nonvolatile and maintained in the SmartMotor’s
EEPROM memory. At power-up, the motor's firmware will adjust absolute position with offset.

0 is the command; x is the desired position at the time the instruction is executed and is a signed 32-bit
integer.

ENCCTL(11,x) selection of encoder resolution relative to 12-bit (4096 counts per revolution). Positive
value increases resolution as a bit shift by that value; negative value decreases resolution as a bit shift by
that value.

x can be from -2 to 2.

EOBK(IO) Command Limitations

The EOBK(IO) command configures the specified SmartMotor output to control an external brake.
However, only output 8 works for the Class 6 D-style SmartMotor. Therefore, the valid EOBK(IO) values
are:

« EOBK(8) to enable
o EOBK(-1) to disable

EOFT(I0) Command Limitations

The EOFT(I0) command configures the specified SmartMotor output to the fault indication. However, only
output 9 works for the Class 6 D-style SmartMotor. Therefore, the valid EOFT(IO) values are:

« EOFT(9)to enable
o EOFT(-1) to disable

Ethernet Error, Status Word 2 Bit 6

The intent of Status Word 2 bit 6 is to inform the user that one or more errors has occurred through the
Ethernet interface. To determine the specific error that has occurred, consult the RETH command
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1/O Control Details

description in the corresponding fieldbus guide.

I/O Control Details

The SmartMotor fieldbus guides describe the details of accessing I/O for each communication protocol.
The SmartMotor™ Developer's Guide also describes I/O control details.

In a local program or serial command, the OR, OS and OUT commands are the same as Class 5. For
details, see the SmartMotor™ Developer's Guide.

For the Class 6 D-style SmartMotor, it is important to note which are inputs, which are outputs, and which
have special functions. For those details, refer to the next table.
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I/O Control Examples

Logical Inout or Possible
/10 P (Selectable) Default Operation
Output .
Number Functions

0 Input only General purpose, discrete General purpose
or analog
General purpose, discrete

1 Input only General purpose
or analog

° Input only Positive limit, or general pur- Positive limit
pose
Negative limit, or general L

3 Input only Negative limit
purpose
General purpose, or index

4 Input/Output capture for external encoder General purpose
General purpose, or index

5 Input/Output capture for internal encoder General purpose
General purpose, G com-

6 Input only mand, or homing input General purpose

7 Input only Drive enable Drive enable

8 Input/Output General purpose or brake General purpose
output

9 Input/Output Suet;i:al purpose or not fault General purpose

I/O Control Examples
To read inputs:

x=IN(W,0,15) 'Reads inputs 0,1,2,3 as bitfield stored into variable x

EIGN (2) 'Disables positive limit, makes a general-purpose input
EIGN (3) 'Disables negative limit, makes a general-purpose input
EILP 'Re-enables positive limit

RIN(3) 'Reads input 3

Scale Factor Calculation - Sample Rates
The sample rate for Class 6 SmartMotors is fixed at 16,000 Hz (16 kHz).
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Commands for Class 6

Commands for Class 6

When transitioning from Class 5 to Class 6 motors, be aware that the commands in this section were added
for the Class 6 SmartMotor.

NOTE: These commands are not available for the Class 5 SmartMotor.
EOFT: Configure a specified output for the fault indication.

GROUP(function,value): Configure group addressing settings of the Combitronic over Ethernet (UDP)
communications.

IDENT=, RIDENT, x=IDENT: Set the IDENT value which is useful for user programs to detect which axis
they are. Report, use in expression, or assign the value of IDENT to a user variable.

IPCTL(action,"string"): Sets IP address, Mask, or Gateway:
action= 0, set IP address; 1, set Mask; 2, set Gateway;
"string": formatted as an IP address and entered as a string;
e.g., IPCTL(0,"192.168.0.10") sets IP address to 192.168.0.10

PRINTO: Explicitly outputs to the COM 0 serial port.
PRINTS: Explicitly outputs to the USB port.

RGROUP(function): Report group addressing setting of the Combitronic over Ethernet (UDP)
communications.

RSP5: Reports network interface card firmware version.

RUSB(arg), x=USB(arg): Report the value of the specified USB status word (specified by arg) or assign it
to a variable.

RUSB, x=USB: Report the value of USB status word 0 or assign it to a variable.

SNAME("string"): Sets a unique PROFINET station name. See the Class 6 SmartMotor™ PROFINET
Guide.

For details on these commands, see the SmartMotor™ Developer's Guide.
These Industrial Ethernet (IE) commands were added for the Class 6 SmartMotor:
NOTE: These commands are not available for the Class 5 SmartMotor.

RETH(arg), x=ETH(arg): Assign result to a variable or report errors and certain status information for the
EtherCAT or PROFINET bus. See the corresponding fieldbus manual for arg values.

ETHCTL(action,value): Controls network features. See the corresponding fieldbus manual for details.

For details on these commands, see the Class 6 SmartMotor EtherCAT Guide or the Class 6 SmartMotor™
PROFINET Guide.
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Commands That Have Changed
These commands have been modified for the Class 6 D-Style SmartMotor:

ENCCTL: Parameters were added for control of the Class 6 D-style batteryless absolute multiturn encoder.
For more information, see Batteryless Absolute Multiturn Encoder on page 65.

PRINT: Corresponds with the value of STDOUT, which is 0 (RS-232 port) by default. Note that this
behavior is different than in Class 5 motors.

STDOUT=0: (Default) Sets internal report commands to the COM 0/RS-232 port.

For details on these commands, see the SmartMotor™ Developer's Guide.

Commands Not Supported
These commands are not supported in the Class 6 D-style SmartMotor:

ENCD, EOIDX, MDH, MDHV, MDT, OC, OF, PID, SCALEA, SCALEP, SCALEV

Commands Supporting the DS2020 Combitronic System

Note that the Class 6 D-style motors support the DS2020 Combitronic system. Therefore, any commands
specific to that product are available on these motors.

For details on the commands for the DS2020 Combitronic system, see the topic "Commands for DS2020
Combitronic" in the SmartMotor™ Developer's Guide.
Features not Available in Class 6 D-Style
These features are not implemented:
» DeviceNet protocol
» PROFIBUS protocol
e |>C communications

e AD1 option
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Troubleshooting

This section provides troubleshooting information for common problems. For additional support resources,
see: http://www.animatics.com/support.html.

Issue

Cause

Solution

Communication and Control Issues

Motor does not communicate
with SMI.

Transmit, receive or ground pins
are not connected correctly.

Ensure that transmit, receive and ground are all connected
properly to the host PC.

Motor program is stuck in a
continuous loop or is disabling
communications.

To prevent the program from running on power up, use the
Communications Lockup Wizard located on the SMI
software Communications menu.

Motor disconnects from SMI
sporadically.

COM port buffer settings are too
high.

Adjust the COM port buffer settings to their lowest values.
This is done In the Windows Device Manager> Advanced
Settings dialog box for the associated COM port driver.

Poor connection on cable from
motor to PC.

Check the cable connections and/or replace it.

Power supply unit (PSU)
brownout.

PSU may be undersized for the application, which causes it
to brown-out during motion. Make moves less aggressive,
increase PSU size or change to a linear unregulated power
supply.

Motor stops communicating
after power reset, requires
redetection.

Motor does not have its address
set in the user program.

NOTE: Serial addresses are lost
when motor power is off or reset.

Use the SADDR or ADDR= command within the program to
set the motor address.

Motor doesn't turn.

Faults not cleared and/or drive
enable not satisfied.

Clear faults (see Checking and Clearing the Status Bits on
page 52).

Satisfy the drive enable input (see Drive Enable Input on
page 33).

No CAN bus signal on the fly-
ing lead cable

HD26 cable DIP switches are set
incorrectly.

Check the cable DIP switch settings. For CAN bus pass-
thru, switches 1 & 2 must be ON, switches 3 & 4 must be
OFF; reverse those settings for CAN bus termination.

Common Faults

Bus voltage fault.

Bus voltage is too high for
operation.

Check servo bus voltage. Check for excessive regenerative
energy from motor due to no/insufficient shunt resistor.

Bus voltage is too low for
operation.

If motor uses the dual-power configuration (separate drive
and control power supplies), ensure that both power
supplies are connected and are sized correctly for the
motor.

Overcurrent occurred.

Motor intermittently drew more
than its rated level of current.
Does not cease motion.

Consider making motion less abrupt with softer tuning
parameters or lower acceleration profiles.

Excessive temperature fault.

Motor has exceeded internal PCB
temperature limit of 85°C. Motor
will remain unresponsive until it
cools down below 80°C.

Motor may be undersized or ambient temperature is too
high. Check motor sizing for the application in terms of
continuous rating. Consider adding heat sinks or forced air
cooling to the system.

Excessive position error.

The motor's commanded position
and actual position differ by more
than the user-supplied error limit.

Increase error limit, decrease load or make movement less
aggressive. Also, ensure you are not voltage limited for the
torque at speed required. If running from less than 48 VDC,
check ratings for lower bus voltages and ensure the motor
is within required torque capacity.

Motor faults on position error
only after a certain amount of
time.

Motor is not accurately
corresponding to trajectory.

Motor sized incorrectly.

Check motor sizing for the application in terms of
continuous rating. Also, ensure you are not voltage limited
for the torque at speed required. If running from less than
48 VDC, check ratings for lower bus voltages and ensure
the motor is within required torque capacity.
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Issue

Cause

Solution

Programming and SMI Issues

Several commands not
recognized during compiling.

Compiler default firmware version | Use the Compiler default firmware version option in the SMI

set incorrectly.

software Compile menu to select a default firmware version
closest to the motor's firmware version. In the SMI software,
view the motor's firmware version by right-clicking the
motor and selecting Motor Properties.

For Further Information...

Now that your SmartMotor is installed and operating, the next step is to learn about its features, commands
and programming in order to create a useful application.

Information on SMI software features, SmartMotor programming, communications, motion control and
more is provided in the SmartMotor™ Developer's Guide. That guide also includes a complete SmartMotor
command reference, and an Appendix of other related topics that are useful during application

development.
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